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DBl (AREREE

solidDB T 74V ) {5 FH s
TIARE A solid-inst « InfoSphere CDC for solidDB OfEREMIZEHIN S

e dm OANY U RTA VA D AEERITLESIMHHEIND
PF—NN— -« R—k 11101 (T 7 #J)V 1)

* InfoSphere CDC for solidDB DfERRFFICEFR S N5

* Management Console/7 7 €A « YRx—T v —MN6A VAT VANDEE
o AN ES

Windows Service L

+ InfoSphere CDC for solidDB D{ERLFHZEFR SN

—T= e TAUL T + TnfoSphere CDC H—E A2 HHT 5 &= (HIAIE. 1 >R > ADH
f) (CE

T—HIN=A - BY | 2P —F soliduser |+ (oidDB F— ¥ N—ANDOT A >+ FeF &, InfoSphere CDC A %

12Ty

INAT— R
admsolid

AHF =5 « AF—
~': SOLIDUSER

TIRIMHTHAF—IHERHET D
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#17. InfoSphere CDC for solidDB DL—H— « 777> hBLUNFy NT—0 T —5 (fiF)

InfoSphere CDC for
solidDB

OB (MRERSA
3574V )

L

Y= N—$kiT — %

cache-node 1964

¢ solidDB ¥ —/N\—~OkiT—% ZfHET S

e RAMKIF, FY NU—JHERIFTIP 7RLVAICTZZENTE
%, InfoSphere CDC for solidDB 7%, solidDB &[RU / — RiZdh 58
&, RA L&D localhost ICT BT EMTEEHT,

o R—bhHFIT. solidDB B —/N—70 listen T HR— b (solid.ini %
BT 7 AIVNTESR) TRITNIERS R0

#18. Ny IR -
b4

NYOIITUR-

T—4 - ¥—/N\—FH® InfoSphere CDC

F—% « H—/)N—D InfoSphere CDC DL—H— -« 77> hBENR Y T — 7 T —

NYJIUR - F—

N LR F—
& e H—=N—IZL>
THIz2)

- H—N—HO |HOH (THERGS
InfoSphere CDC EF 74V ) {5 L
TIAY A% BE-inst * InfoSphere CDC for solidDB D{ERLMHIC EFH S NS
e dn AR RTA DAY D AZERT D EZICMHINS
H—/N— s K= 10901 (77 # )V b

* InfoSphere CDC for solidDB DfERRFFIZEFK I N5

+ Management Console/7 7T A « XX —T % —INSA U AY 2 ANDEE
FElRE I AT

Windows Service L

—Y—ThT Tk

* InfoSphere CDC for solidDB DfERRFFICEFR S N5

* InfoSphere CDC H—ERZEMTLHEE BAIK. 1> AY > ADH
IR) 1T

F=HR—=Z - 0F
1> T=%

NI R « F—
A e —)N—ITL>
THRD

s HHTAHANY IR « F=FR=Z20OT A > « T—4 BIOEER
REERET 2

HLIZ. FHTZNY IR - FT—=% - $—=N—HOD [InfoSphere
Change Data Capture DL K « 1—H—F[IFT&EE O T4 X ~—

VDRI BBRT—F X=X, A—H— - THT >~ BILUEIF

=] Oty arEBRLTILEIN,

Access Server

Z19. Access Server DA —H— « 7 hHr > NBENR Yy KT — 0 kT —4

Access Server

OH (THERIGS
574V )

L

r— &S 10101 (F 74V ) | Access Server DA > A M—)UE (Windows) FE7ZI1FAEKIF (Linux B
X UNIX) ICEF I NS

* Management Console ICHO7 A 295 & EITHE
Ry r 75 :L:_-b“\v_%: Admin o Access Server D > A h— )L (Windows) F72I13Hip (Linux 3
(AT LEME) (T 74V 1) LN UNIX) ICEEIND

AT —R: ucl23  |* Access Server AT LAEREDI—TF—HEHEET S

+ Management Console ICHO 7 A 295 & EITHE
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Management Console

7% 20. Management Console DL—H— « 77> NBLNF Y NT—7 kT —%

Management HOF (TRERGS
Console 3T 74 L
aryA{>-5=% :Lf_qj:_%: Admin |+ Access Server D1 > A4 ~— LI (Windows) F 7213k (Linux B
(T AT LEHE) (T 74V 1) L UNIX) ICEEIND
XA T —R: ucl23 |* Access Server AT LAERED I —HEHET S
YN * Access Server ZFETTHT—I AT —23 > DRA N (AT A
%) FR3ELE IP Y RLAZERET S

* Management Console % Access Server \JHfid DDA NS

"= &S 10101 (T 74V 1)

e Access Server D-f > A M—)UFF (Windows) E7zIIMHERE (Linux 3
LN UNIX) ITEFESND
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= solidDB H—/\—

A% 07%:DBA

A F—~<:SOLIDUSER
KRR +4: localhost

R— &S 1964

T
TCP/IP 1964
v

InfoSphere CDC
for solidDB

A4 AR AL solid-inst

R A k4 cache-node
R— +&ES: 11101

=|| 1 —%—4%: soliduser
/NAJ— K: admsolid

InfoSphere CDC

d—H—4%: admin
INA T — K:uc123
7R R k4 db-node
R— +&ES: 10101

A

Management Console

tt

TCP/IP 11101
cache-node localhost

TCP/IP 11901 TCP/IP 10101

T—8R=R

:_ ____________________________________ l: v v

L RWHTIVUR-F—EAR—2@ | =1 InfoSphere CDC

! InfoSphere CDC i —| Access Server (AS)

| 4 URH U R%: BE-inst : A—+H—%: admin

! R— F&ES: 11901 i INA T — F:uc123

i RA ~4: db-node : RR k4: db-node

| BE 7R— ~&%5: 50000 ! R— k&S 10101

| f |

i TCP/IP 50000 :

| \ |

l RYGIUR - ;

i 7_'_9 - H—/\— :

_____________________________________ db-node

[X] 12. #i: Universal Cache DL —H'— « 717> hBINT—FN—X kT —5

54
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4.2 solidDB Universal Cache FI® solidDB H—/\—DA X =)L &

17
4.2.1 solidDB Universal Cache FH® solidDB 3 —/\—®DA >
A=V
FIE

1.

Java 7 2% A LABREE (JRE) £7z1% Java Development Kit (JDK) N— 3 >
142 PIBgEZEA > A M=V LET (F7ZA1 A =L L TWRWER),

solidDB - > A b—F—%%Ef79 31214, JRE /213 IDK 14.2 DAENHET
@—o

H: Linux A5 A TlX, GNU Compiler for Java (GCJ) [3HHR—FINTNE
B A

o aO—RUEA ARV« A A=V FRIFA A=)V DVD T. ZfEH
DARL—=F 4 27 « AT LHDA A=)V - Tal I L Ty 1IVERL
£7,

e solidDB-7.0-<platform>.exe (Windows)

e solidDB-7.0-<platform>.bin (Linux BL I UNIX)

AA=I - TOT I LTy ANEIT TN Uy 7 LET, solidDB 1 >
A=)l T4 P — BB L £,

TA Y= ROWRIIHEST, 1 A M—IVETETIEET,

{#: Linux BELWY UNIX ARV —F 4 > 7 « VAT LTI, 1A M=J)VICHEH
T574 L7 M) —IZRHLUTEZIAATRETHLILENHDET, 1 A M—
W 7T I LMEDT 4 L7 N —Z2ERTERWEE, BloT L7 M) —
DIEEZRIT o> Ty HEInEd,

ZEH D solidDB ZfEFR L. solidDB DHEARMZIIEITHAL TBNVWTL S
AR

FRNCDOWTIE,  TIBM solidDB X5 — K7 w7 « 71 F | @ [solidDB D1
A M=I)LDEEF] D7 a ., B [IBM solidDB &1 K 2258
LTL7Za,

RDERY

[ T4.2.2, solidDB for solidDB Universal Cache D##pkJ |

4.2.2 solidDB for solidDB Universal Cache DRk

InfoSphere CDC 77 / 02— solidDB Z 9 %121, InfoSphere CDC for
solidDB 7% solidDB =& N—RIZHf L T, T —F 2 EHTEZ DL DT, MO
RECEBTLHENDDET,
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B BHIIC

ZOt 7 a T, #EMN solidDB OEIICHALTHBO., #HzEX. [IBM
solidDB EHE 1 K1 O [solidDB DEE] . BX TsolidDB DL Ot
A R ILTWAZEEZEELTWVWET,

FIE
. T=IXR—AREEZLy b7 v ST5-012, EET 0L 27 FU—, solidDB 5
—IR—A, BXOL—HF— - 7HhHo B2y 7Y TULET,

FIEIZDWTIE.  TIBM solidDB EHH 1 K1 @ [ 57— X—XDHH1ERL]
EHRLTLIZE N,

| =28 ¥

solidDB 21 > A h—J)L L7z, solidDB 1 > A k—J)L T4 L7 FU—IZLLF
DTF4 LT M)—=MHDET,

<installation directory>
bin¥
eval_kit¥
standalone¥
cdc¥

samples

solidDB 1 > A h—)V « T4 L7 FU—N®D eval_kit/cdc T4 L7 U —%{E
(T4 M)—ELTHHTEET. 22T, solidDB % solidDB Universal
Cache 7213 InfoSphere CDC L 7Y —a > &—fICHERT 520087
VD solid.ini 77 LIV AD TWET,

2. solid.ini {7 7 1)V D LogReader 273 a LIZHBHERINT A—~ —&%

HEpZ&icky, ay - Y—F¥—zHElL £,

a. LogReaderEnabled #pk/\ T A—% —% Tlyes] IZEEL X,
[LogReader]
LogReaderEnabled=yes
Z#UZ. InfoSphere CDC L 7'J 4 —3 3 > T solidDB &Y —A& « T—4 X—
AELTHEHT S0 ETY, 7727 ) —fEld nol TT,

b. MaxLogSize MEk/NT A —%—T., hI>H¥ U al - O DREAR—AD
YA XERELET,
[LogReader]
MaxLogSize=<MB>
MaxLogSize /NT A—4—Id, F¥ vF7 v 7OETIHEHGEROY - 77
ANDOE (VA1 X) ZRELET, OV - 77 IIVORKYA XL, EHTHE
BT AR + AR—ABEUOF Y v F 7 v TRBEITIRDETOY Y VKH
ICE->THRZDET, 7727 bYU—fEIL 10240 (10 GB) TY,

07 « U—=%—=WWE%EE, ffESnz0” « 771 IREAR— AL,
WIZWIEWETHERAINET, N Z 7 v IREFINTORWES, £
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7213/XF A —% — CheckpointDeleteLog 7% [No | IZEXE SN TNSHEHEIC
W, 0% - Iy AINIEXDREBAR—ZAZEETLHZENHDET,

c. MaxSpace BN T A—F—ZHKRELT. ¥ - LA—FDALVAEY— N
Iy — YL AERELET,

[LogReader] )
MaxSpace=<d% - L O— R#>

MaxSpace /\T A—4%—{&, 20y NI THEHAZINE A > AEY—-0OF -
—H— e N Ty—OYA X% (OF - LA—ROKT) FELET, Oy -
L d— ROEKEIL, PRINDAEAMN—A D - A ZXIZE> TRV E
9, 777 MJ—fElE. 100000 O~ - L O—RTT,

0z - Lad—RovA Xid,. N FU—0) {751 XEMAYT—4 - F
==y ROBENA FZEMELEZHDICRDET, Ny 77— noiFn
WZixb e, ZIN—Tw k- 20y MUVNEASIN, OF - J—F—-- Ny 7
7 —IIRENTELET, BERT O INET,
3. BREIIRUT, WIF—RVAET—HIR—Z - &y F7 v FICHET 520Dl
DHEREINT A—H —Z WU X T,
* Logging.DurabilitylLevel

T 74 )L b TIE. solidDB H—/N—OFkitE L X)UIiZ 5w 7 2
(Logging.DurabilitylLevel=1) [CHEINTWVWET, ZDHFA. solidDB H—
N—=IZFPHIL IR WEENRAET 2L, BRFO T P 2 a >ikbisikiE
272 B ATHEED D D £,

INZEHIET 572012, LLFD solid.ini 77 1IVOFRET. Fifik L )L
ZARUYZ NCERELET,

[Logging]

DurabilitylLevel=3

H: ARMUZ MREGMERETIE. Uy 7 AFtt &g LT, X7 —< >
A TARNZBEGMENA U E T, solidDB HA (HotStandby) #§pkAY 2-Safe L 71
F—ar 7O (T7HIVE) THEHHASNTWDHE, UTv T Ak
GltElZT—HEED) AR LICHEHTEET,

¢ General.DefaultStoreIsMemory

774 )V N Tld, solidDB R#DA KL — « A4 FiFA 2 AEY —%K
(General.DefaultStoreIsMemory=yes) IZFXE SN TWNET,

e Sql.IsolationLevel

T 7 # ) N TlE. solidDB 738 L ~X)LiZ. READ COMMITTED
(Sq1.Isolationlevel=1) I{ZEXE N TWET,

4.3 InfoSphere CDC for solidDB DA X b—JL & #8Rk

InfoSphere CDC for solidDB Z- > A h—J)L ¢ 2I2id, 1 > A =)L« T4 HF—F
DOFIEIHENET, o > A F—)L#%. InfoSphere CDC #§pk>Y — )L &AL T,
InfoSphere CDC for solidDB -1 > A% > A %Rk L £7,

4 1A=L EREK 57



B BHIIC

DT ZERL T EE W,

* solidDB Y —N—"EEL T3,

+ solidDB T—4% X—ZADIERMNTE T L TWb,

* s0lidDB T— N—ZADIL—H—%E/NAT— RINpnoTnd,

* solidDB H—/N—7% listen §5%y 87— « 7 RLAER— R NESNGN-T
W5,

* InfoSphere CDC for solidDB 1Z& 2 A% 77— KDIERH D AF—< & HiHIHE
L Th2M BEOAF—FZERLTHS,

FIE
1. InfoSphere CDC for solidDB % > A b—I)VL %7,

a. FUoO0—RLUEAAR—I A A=VFRIEFA A=)V DVD T. T
HRHOARXL—F 4 2T « SATLHADA A M=)V - TOTIL - T A
WEHRL£7,

setup-x86-solid.exe (Windows)
setup-<platform>-solid.bin (Linux B X UNIX)

b. {1 >AL=)b-TOTIL - TyAIEy TV )7 LET, solidDB
ARV e T = RO L XY

c. U4 P —ROERIIHST, A 2AM—IVEETIHET,

7: Linux BEY UNIX ARV —F 4 27 « AT LTI, A A=)
HHTE2T 4L b —ICH U TEZAAFRTHHLENHDET, 1>
A=)V - TOATILBEDT 4 L7 MU —2ERTERWEE, BOT 4
L7 M) —OfREZERT 7O T RRHEINET,

A2 AR —=IVDO#IHVIZ, InfoSphere CDC HALY — )L DicE) 2 2R L T,
InfoSphere CDC for solidDB A > A% > A &Mk L £,

2. Wik — )V U T, InfoSphere CDC for solidDB DF L WA AY VA%
ERRL £7.

* | 14.3.1, InfoSphere CDC DFi LA > A > A ZBHT 5I121E (Windows)J |

s 162 X—=2® 1432, InfoSphere CDC DHT L WA > A% > AZBINT 51213
[(UNIX BE O Linux)J |

RDYRY
64 X—>2D T44, )Ny 7T R+ F—4 « 4 —/)N—FH D InfoSphere CDC D1 > A|

[F =V ERRRS [TitEA £ T

4.3.1 InfoSphere CDC D#HL WAL Y RH VR EZEBMTSICIE
(Windows)
IR BRI

1 > A h—)V#RIT InfoSphere CDC Di#IDA > A% > AZWHKT 5551, TD
FIED ATy 7 3 ITHEAET,
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FE

. AR - 70 7RT LFOaxX Y REEEINET 4 LY MY —THET

L. BEpYy — IV Z2EEHL £7

¥<InfoSphere CDC Installation Directory>¥bin¥dmconfigurets

2. Ux)VAL s Ayt— T,

[OKJ #27 Uy 27 LTHATLET,

3. [IBM InfoSphere CDC New Instance] %1 7117 + 7Ry 7 XD [Instance] fH
BT, WFOA T a v el TEEd,

FTayv

GBI

Name

InfoSphere CDC f > A% > AD&Hi%E AT]
LET, ZOLRNII=Z—I THELEND
DET,

Server Port

InfoSphere CDC 7%%, Management Console 3
FOZOMDY—N—ZEITLTVWD T F1
Th U= AT —a OB
THR—FEBEANLET,

F: ZOR—FEFIE BHCY—N—IT1 >
A= ENTWBHDOT TV r—a>T
AT L3 TEERA. ZOR— &S
¥, Management Console DY 7 €A « ¥+

=IOy —  N—ZART T4 TTT—4 « A b
TDTIEA + NTA—F—&RETHLEE
WAL E9 . InfoSphere CDC V&, T 7 %

)V TCPIP R—h&SD 11101 ZFRL

%9, #L <I& Management Console D&

Bl2ZRLTES N,

E: MU/ —RICEROA DAY A%
Ab=NT2HE. &1 2AY 2 ADER—k
HBEFLZ -V THHIUENHDET,

Auto-Discovery Port

ZDRw 7 A %R LT, Access Server O
SREINDIA— T4 AANY— - TO—
RFE¥Y A NTHEHATS UDP R— FEFZEA
NWUET. F—FT 4 ZAHNY—IZDNTEE
L <1&. Management Console D&E¥F} % S
LTL7ZE0,

Maximum Memory Allowed

InfoSphere CDC IZE| D5 RAM D K&
BEANUET, WK 2E&1 25 2D
< &b 64 MB ZEIDIRDZVLEND D F

T, TI7HIIN BT 32 Ev b1 RS
> AAZIE 512 MB @ RAM DEID RS .

64 Ev hDOA 2 AH AT 1024 MB D
RAM 2EIDIRSNE T,
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FIFav B

Bit-Version DTFoWsnhoA 7 a > 28IRLT, 7
—HR=ZADEy b+ N—=T a3 VEBRLE
ED

e 32 Evhk

64 Ev bk

InfoSphere CDC % 32 Ew bk - H—/)N—I(C

A A= LTWBEHE, INs0F 7>
a A TEERE A,

4. TWindows Service] fEIH T. InfoSphere CDC B —EXDBMRICHEHRT 27 D
ChEBETEET, LFOF T aondnnz@#RL £9,

FTrav G|

Local System account 0=y« AT LEBEDT D2 R T
InfoSphere CDC H—E A &L £9°,

This account HELZI—Y— - 7> M T InfoSphere

CDC Y —EAZBHIBLET,

7 > M. <domain>¥<user name> D7
=Xy N THRETLHILENHD LT,
<domain> VFERED R AA 24T, <user
name> 3IRE LI RAAL COFRN RO T A
e A=Y —HTY, AEa—F =0 KA
A > DO—FTIRWEEIL., <computer
name>¥<user name> Z{EETEET,

MPassword| 1 27 ZB XN [Confirm
Password| 7~ 7 Z1Z, R L 7= Windows
A—H— « THD > MIBREREMT 5N T
WBHNRAT—RZANLET. InfoSphere
CDC DA > A b—)L#IZ Windows L—H
— T hHI L NDISAT— REEFLEZEE
2. Windows Services] -1 7 1O/ Z{#iH
L T. % InfoSphere CDC B —t AIZHUERH
EINTNENAT— REEHTHLEND
DEJ,

5. [Database) T, L7 U —2a  HOREZFOT —FIRX—ANDT VA
R TEET, COFEEZTTTDI2E. AT LEMEHRENLETT,
1. Management Console D7 7t X « Ix—T v — « N—AXRT T4 TTT
=%« AT ZBML, 21— —IZZDT—FN—ZADT 7 L AR Z LT
ZX5X91T/20 £, 7L <IX. Management Console DERIZHMML TS

2%
FIFav B
User name RELET—IR—ADI—F—%Z AL

EIR
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FTav B

Password BELET—IR—ZADNNAT—REAHL
EC
Metadata Schema InfoSphere CDC A% T —% RIZHEHT 5T

— I R—=ADAF—IZERRLET,

T4 NELT, ERTANLZIZ—T—
HIMEASNET, A A=V INTNVS
B InfoSphere CDC - > A% > AMZEDT
—HIR—=ATHEHL TS AF—T 2R
T. TEOAF—TYEEETEELET, DA
F—<d, 1 A M=V DRiHRESEO—E &
LT, By N7y TEZEBRETELEND
DETJ,

O AYT—F - AF - BTRLT
ZEHLTCLIZS N, T72)L T
solidDB DT RTHDAF—4% (hyay
%) 1E. KXFTY,

Advanced [Advanced] "% > 2L T. solidDB
JDBC RIAN—DHERE/INT A —4 — %25
TZ£J., IDBC FIAN— - NTA—4F—
DFMCOWTIX,  [IBM solidDB 7’0075
Y= AR EBRLUTEI N,

6. [Server] fHIT. T—¥ OEHGEELIIER CEL, LT =2 a  HOT
NTORZEZE solidDB Y —/N—Zlk TEEd, H—H—/)N—F7/&i3 HA #
Ji% (HotStandby) ZHERR CTE £ T,

FITav B

Single server 8 L7z solidDB H—/N—DHK A hHER—
rEBEATILET,

Enable SMA ZOFzv 7 - Ry Al solidDB THA
AEY— T EX (SMA) 2 AT 2855
IR E T,

HA Configuration (HotStandby) FELZ 1 RBELY 2 K solidDB H—/\—
DIRA MG ER— b BEEEANLET,

7. TOKJ 2717 LT, InfoSphere CDC - > A% > ZADHRRFHREZHREL £
—a-o

8. [Applyl 227U 27 LT, MRV —IVOEEEREFELET,
RDH XY
Hspk 252 7 L 71, InfoSphere CDC ZRBHIATE X7,
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4.3.2 InfoSphere CDC DFH LWL RH U RZEMT BICIX
(UNIX & T Linux)
158 BHIIC

A > A b —)V#RIT InfoSphere CDC DDA > A5 > AZHKT 5551, TD
FIED AT v 7 4 ITHEAHET,

FIE

. AX>R-7O027 T UFOaY Y REEESINLT 4 LY MU —THET
L. #pky —I)V&iE L Ed,
/<InfoSphere CDC Installation Directory>/bin/dmconfigurets

2. Ux)VAIL - Ay t— T, Enter F—Z2#L THITLET,

3. InfoSphere CDC DFT L WA > AH > A ZBINT 57012, 2 2 AJ1L T Enter
F—ZWLET,

4. InfoSphere CDC 1 > A% > AD%4HGIZ AT L. Enter F—Z#HL X7, 1A
G OABEA = THAHBENHDET,

5. InfoSphere CDC 73, Management Console X UNEDMDHT—/N—ZFETL T
Wb 547 > U= A7 —a E0BRIHEHATLIR—NESE AN
L ¥, InfoSphere CDC ¥, T 74 )V K - R—KFFEFD 11101 2FRL F
9, Enter +—Z#L 7,

H: ZOR—FEBEZ FCH—N=IZA > A R=ILENTWBHOTY T
—2a THATAHZEIEITEER L, ZOFR— hEFIL. Management
Console DT 7 XA« XHXx—V v — « W—ARI T A TTT—H « ARTDT Y
TANITA—F—ZRETHEZITHEHLET. #L <L Management
Console DERIZZHL TI7Z3 W,

H: B/ —RICEERDA DAY AZ2A A NIV B5E, &1 A5 >
ZDHR— FEFEL=Z—V THIHEND D ET,

6. A—hrF 4 AH/)NU— UDP h— "&EH%EASIT 50, Enter F—ZHL T
DISABLE OF 7 # )L MEZMAL £9., ZDOHR— FF 1L, Access Server 25
BREEINEZF—FTA AN — - TJOoO—RFEv A hTHASNET., F— b
T A4 AHNY —IZDNWTFEL <IZ. Management Console DERIZZIL T 72
I,

7. InfoSphere CDC IZEID RS RAM DRKEZANLET. HWRITLHIEAL A
5 A< ED 64 MB ZEIDIRDZMLENHODET, 774V ETIE, 32
EY hDA A% > ZIZId 512 MB @ RAM DNEIDIRS, 64 Evw D1 >
A5 > AIZIE 1024 MB @ RAM WNEIDIRSNET,

8. HEEkd % solidDB H—/N—DHERY 1 7 & EIRL £,

FIFav B
Single server 1 ZANL. Enter ¥—Z#H L £7,
HA Configuration (HotStandby) 2 ZAJiL. Enter ¥—%&IL £7,

9. AT BT 1 TS THRA MR ER—FEFEANILET.
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FTayv

GBI

Single server

1. BELZY—N—DOFRARNGEASL,
Enter F—Z#H L £9,

2. FELEZEY—N—0DOR— &ES2 AN
L. Enter ¥—2#L*xJ., 7734k
1% 1964 TY,

HA Configuration (HotStandby)

1. #BELE 1 RY—N—DFRAMEEASN
L. Enter ¥—Z2#L 7,

2. {HELEZ 1| KF—N—DR—+HE5EA
1L, Enter ¥—2MLF9., T 7L
M 1964 T,

3. H/HELRE 2 RP—=N—DOKRANLE AT
L. Enter F¥—%#HL £7,

4, HELE 2 RY—N—DR— hEF5ZA
71U, Enter ¥—2MLFd, T 72
M 1964 T,
A1 RIS 2 RENIHIO / — RICE &
INHEHEEINTWVWDD, 1 Xfll&
2 KDOFT T 4 hOR—FEFIZRC
TY, HAIE. FMOEKT. 1 KY—
N—& 2 kP —N—%FLC/—RICEE
THHEIE, WHOT 74 ) ~DR—
rEHZFECICTAHIEFITEEE A,

10. B U T, solidDB THEAEY — - 771 A (SMA) 2FHTE5LHIC

BEIRLET,
FTav B
Use default settings n ZAJ1L. Enter F+—Z#ML £7,
Enable SMA y AL, Enter F—2Z{L £7.

11. BEIHEU T, Efll/SNT A—4— (DBC /NT A—4—) Z#ERLET,

FTvav

GIL|

Use default settings

n AL, Enter F+—Z#HL E£7,

Modify settings

1. y ZA/1L. Enter ¥—Z2#L £7,

2. <parameter>=<value>;<parameter>=<value>;... H§3(
AL T, NIA—F—REEZANLET,

F: HA By R7 o 7Tl NTA—F —
solid_tf_level |, 7 7 )L hC 'CONNECTION' IZ7%
EINTWET,

12. BELEZT—AIXR—ZADIL—H—%%ASL. Enter +—2ZL 7,

13. HELIET—IN—ADNAT—FZAJ L. Enter T—ZH#L X9, MY
=N, T=HIN—ATAF—YZEMBLET,

4. FEHT2AYT—4 - AF—XITHIET 2HFSZ AN L. Enter F—ZHL X

ER
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16.

LTI R ANV AT BT 4 L7 b =D AEANLET,

Enter +—Z# L £, solidDB 7 —% X—A & InfoSphere CDC Dili 512, Z
DT 4 L7 b =T 9 HHe M0 MR & Z A DHERRN N BT,

H:

* InfoSphere CDC DA > AY > AT &I, BisbT 4 L7 M) —2[HT 24
EINHDET,

s ZOT4 L NU=IZE, LTUT—2a AT —IR—AEKNEEND
ZENHVET, ZOT4 LI N —ADIL—HF— « 77 AR ZRET
HEZXIL, ZOZEEBELTIEZ N,

FR%Y — )V IZ X > T InfoSphere CDC A > A% > ADMERR I N, 1 A5 A

ORtEZERT O T B EINET. y ZANLT, 1 2 AF > AZMIAL

7,

H: IRICEK > THEED A DAY D ADAY T =R EEEINELS ELES
G, WYy —lick->Tr7o > IR ENEd,

44 Ny OITV R -FT—4 - B—/N—H®D InfoSphere CDC DA VR b—

WV EABRK

N
“®
57

WL R e« F—4 « F—/)N—H®D InfoSphere CDC % > A h—)L T BT,
SAR=I s U4 = ROFIEIHENE T, 1 > A M=), InfoSphere CDC ##
W —)VZ&@H L T, InfoSphere CDC 1 > A% > AZkiik L £7,

B BHIIC

Ny LY R e TF—=4 = N—0BEHL TNDZEE2MHRLET,

N LTU R« F—=IXR=ZZERL THBEET,

NPT R e F=IR=AHDI—F—ZHENAT— REHERLET,

N LR e F—=%«H—)N= listen 5%y hT—2 7 RLAER—
EEEHAL £,

InfoSphere CDC M A Y T —4 RZVERT HBRICHEH T 5 A F—< Z2HBU/ERL
THLIM MHFEOAF—TZERLTHBEET,

F&E

1.

A YA BV DRt SR 2 R L £ 9.

AP AP—NVEFIIONTIE, Ny IR - F—=% - F—N—HD

[ InfoSphere Change Data Capture DL > R « 1—H—[aF&E O T4 2> K
—IVDRETIZY DET > a VITHHANG D £T,

Ny 2LV R F—% « —)N—J InfoSphere CDC Z1 A F—IVLET,

FLLIE. NI TR -FT—% - —)N—HD [InfoSphere Change Data
Capture DL R « Z—H—[ET&ERE O [infoSphere CDC DA > X ~—J)L] @
vy alESZRLTEIN, A2 AM=)LO#HDIZ, InfoSphere CDC I
B — )L DL Eh & %K L T, InfoSphere CDC 1 > A% > A&tk L £97,

. B - VEEHLT, NIV R F—% « —N—H® InfoSphere CDC

DFLAAL DAY LV AZERLUET,
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LI NP2 R - T—% « $—N—H®D [InfoSphere Change Data
Capture DL R « Z—H—[AFEE O [infoSphere CDC DL DY 2 3
CEZRLTEZ N,

RDEYRY

[ T4.5, InfoSphere CDC Access Server D1 > A k—)L Rk |

4.5 InfoSphere CDC Access Server DA R b—)L &8k

Access Server 2 > A R—=)LTBITIE. A A=)V T4 P — ROFIEIIHENE
To A ARV 2y T THRIERAICEHNER—NERBEETET7 74T

+—=IVELFZOMOeF 2T 4 — « ANZALZMEHL TWAHHEIX, loa

S Ea—%—M Access Server U—E AL DWBEICHHATELR—MNEIEET 24

BWINHDET,

F&

1.

(infoSphere Change Data Capture Access Server 354 (X Management Console |
[r>ZARL—2a2 - 4R OFBHICHS T, Access Server & > A h—)l
LET,

H: Access Server ¥ U 2 M3, A A M—IURFITER SN E T,  Access
Server 7 1 2 M3, AT OEDITHEHINET,

* Management Console 75 Access Server \ZO7F >4 5,

¢ Management Console TIL—H—&tF5—% « A N7 ZEHT 5,
REBICOKHBETHIUL, o> Ea—4%—7N" Access Server Y —E X & DHE(FIC
HHTELHR—hEHEELET,

FIEIZDWTIX,  TInfoSphere Change Data Capture Access Server 3N
Management Console D > A L —2a2 « 7714 R @ TAccess Server D1 >
A=) DU a L ESRLUTIEE N,

RDERY

[ 74.6, InfoSphere CDC Management Console D > A b —)L E K] |

4.6 InfoSphere CDC Management Console DA >R b—JL & 18Rk
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F&

1.
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=L ET,
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T. Management Console 20771 > L %7,
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RDEYRY

« [Help] > T[Help Contents] A= x1— - /NAZffif] L T. Management Console
ONNTXEEFIRUET,

+ [Management Console ZfHL7ZF v v adty 7 v I 7 a > O
12> T, solidDB Universal Cache Ot N7 v 7 Z&&ITL £,
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FHMEHOL 70— ay s BT AT T a o EERT B HEOEARN I %
ML ET,

B BHIIC
o BEITAEMNY I IR « T—IR—AHEETHIEEZMHRLET,
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e EVXA N —ILZHE-S T, EEL WL U r— g FHAIZERLIZZ L 20
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FE
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D [Management Console D7 > (Access Server NDIE#HE) Ot a >
EZHRLUTZE N,

E > b: Management Console D7 7t « X %x—T v — « N—=AXRT T4 T T
E¥T 21203, 77— - AT &Y — - 7 hHU > NOEHFEEZFF O AT
LERETRINERD ER . AT LEMEDTY /1 > Mid, Management
Console D > A b —)VRFIZIERRBE AT,

2. solidDB BEUNY I LU R « F—IXR—ZHDF—% - A7y b7y TS
LET,

a. solidDB BLXUNw VLY R+ T—=IXR—=ZHDOH L WF—% - A T ZEN
LET,

1) TAccess Manager] > [Datastore Management] %7 U w7 L %7,

2) [File] > TAccess Server] > [New Datastore] =7 w7 LE7,

3) 7—4% + AT D%4HT%E [Name] Ry 7 A AN LET,

4) W% [Description)] Ry 7 AIZANLET,

5) InfoSphere CDC %1 > A =)L L7=H—/N—DHKRA N4 F 2134k 1P
7 RL A%, [Host Name| "7 AIZAILET,

6) T—HIN—A + B—=N—Dh—rFEF%Z, [Port] Ry AITANILE
KR

7) B—/)N—% ping LEd, L7z E. InfoSphere CDC %1 > A b—
WL N—DF A TBIOEBDON—a > BBEEEZD, T4 « X
EY - TONRT 4 —RRENET,
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DO FIZE DB THHENRHODET,

1) T[Access Manager] > [Datastore Management| %727 U w7 L £,

2) T4+ AT ERRLET,

3) i7UwZ L. TAssign User] ZZIRL £7,

4) 1 NOA—HP—ZERT 20, Cul F—Z2MLLEFEROLI—T—%
ERLET,

5) BN TA—Y—ZHALET., [OK] 27Uv L TT—% A7
DT T A )N S DERI/NT A—F —&ZFANDD, £LIFRRLZ21—H
—DNTA—F—ZEHLET,

c. BEZEZHMNTTSITIE. Access Server MO UKL T, FiEERL £,

1) TFile] > TAccess Server] > [Disconnect] 27 1) v 7 L %7,

2) [File] > TAccess Server] > [Connect] 71 »v 7 L£7,

£ L <. TnfoSphere Change Data Capture Management Console EFEITA K]
D TF—=% - 87Dty K77 (Setting up datastores)) DX a > &5
LTLEE,
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RI O TH T2 Taoty K7y 7] Ovra2BRUTLES
W,

EVb: IELT, ROFIETIE, BAHMML T —a VEERTOY T AT
U7 a w2 ERT 2 HEEHHL ET,
a. NI L2 REMNS solidDB NOFMBT ALY T a 2Rl £,
1) [Configuration] > [Subscriptions] 27U w27 L %7,
2) Juyx s h&427Y v LT, [New Subscription] %KL FT,
3) NwZ L2 RMN5S solidDB NOHFHY T A7) T a>Dbiiz
Name] Hw 27 ZIZANLET,
4) FHYT AV T a D% [Description) 7w 7 ZICANTLET,
5) NwZ LR «F—%+« A 7% [Source] VU AMNSEIRL ET,
6) solidDB 7—% « A~ 7 % [Target] ) A NNSEIRNLE£T,
7 TOKI 227Uy 27 LET,
b. solidDB N5 /N\w 7 LY RANOFHYT T AV ) T a &R LET.
1) [Configuration] > [Subscriptions| #2717 L£T,
2) 7Oz h&E427Y vy LT, [New Subscription| Z3#ERL ET,
3) solidDB MB/N\Nw 7 T2 RADOHMRY T AV ) 7 a > D4bi%
[Name] &7 ZIZANLET,
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4) YT AU T a Ot %E Description) Hw 7 ZIZANLET,
5) solidDB 7—% + A b7 % [Source] U A FMN5ERL LT,

6) NI IR +F—4%+ A7% [Target] U ARNSRIRLET,

7 [OKlI Z27Uv 27 LET,

4. MDY T A2V T2 arT, LIUr—2aHOoEEIYyTLET. 20O
FIETIE, Ny TR« F—% « H—)N—IZ, solidDB T—&F XN—ZIZF v v
DAaTAERNEENTNS ZEEZ-ELTVET,

a. [Configuration] > T[Subscriptions] =71 v 7 L£7,

b. Ny L2 ENS solidDB NOYT AV )T a &R RLTHEI Y v

L. [Map Tables] ZZERL X7,
. TOne-to-One)] Yv E> 7V ZZERL T, [Next] 271w LET,

d. T7—RX—Z, AF—<., £/kiIFK% [Source Tables] J A SN SERL.
XyETIHEHTES T —IR—ADEEFRLET, ENY A Ik
WHAIR, T—R—Z « Y —FLEFAF—TELHI U I LT,

[Refresh] 227U w27 LET,
Source Tables] J A RM5, Xy 795 1 DU EOREAEIILET,

Next] 227U w27 LET,

[Create new target tables] =7 1) w27 LX7,
[Complete Mappings| ¥ 7O/ TXwE 7 %MA L., [Next] 271
w7 LET,

i XvETOENEHAL T, [Finish) 27U v 27 LUE7d,

= 0 oo

L <&, TInfoSphere Change Data Capture Management Console EFETTA K|
D IROYYEZT) O a a2/ UTIZEN,

5. IV EVTZEIZ, EDVRZ - V=)Vl Tl & 2E& UET.
L <X, TInfoSphere Change Data Capture Management Console EEE/T1 K]
O THEAERHBEIOBERORE] Ol a a2BRL T30,

6. A7 a: IV—AHDOXFEYy MERERELET,
solidDB 7—# X—Z « &— R Unicode

(General.InternalCharEncoding=UTF8) D&, X FT—4
(CHAR. VARCHAR 72&) OFODIT > I— K% UTE-8 IZ&%EL £,

## L <13, [solidDB Universal Cache T® Unicode 7~ —% N— Z 35 L 51|
[Unicode 7—# X—Z Offifil& SR L T ZI W,

7. YITAPY T arTLFUr—a 2L ET., vy azflihd s
WZid FERR L2 7 A7) T a Tl I — 2 EBBLET,

L <X, [InfoSphere Change Data Capture Management Console EEE/T1 K]
OIS TIO) T3 >TOL TV r—23 > DEEKTI O®Y v az2s
WL T7ZE N,

YR DHER

FlELT, NPT TR F—HR—Z &L solidDB 57— X—ZADMIZ WG HEL 7
Vir—sar 72707 a ety b7y 7T LELE, EE65MDT—FN

5 Management Console ZfffHL7=Fr v adty h7v7 69



—AWICEHEZMA S &, InfoSphere CDC L 77U r—a > « AHZZXLIZED, b
D—HDT = R— A ZDEENEHINET,

Bl 212, solidDB SQL L7 1 % — (solsql) ZfifiL T. solidDB H—/N—T SQL
AT—hAhEFETTHELET, TDH. InfoSphere CDC I >R —F% > MIX
ST NI LR« F=IR-ZAEENEHRINET,
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